
Model ST360 Radiation Counter  

 
The ST360 Radiation Counter combines many features into a single inexpensive instrument. The classic nuclear 
scaler design has been expanded to include a preset time function, a digital rate-meter with alarm, a digitally 
controlled high voltage supply, and computer interfacing via RS232 serial or USB formats. 

The ST360 includes BNC and MHV connectors, and a precision high voltage supply that is adjustable from zero 
to +1200 volts. This supply provides 0.5mA at 1200 volts making it suitable for scintillation detectors as well as 
GM tubes.  

The preset time function enables the user to acquire radioactive events for a predetermined number of seconds. 
This is useful for accurately comparing radioactive sources. 

The rate-meter function is ideal for contamination survey work because it instantaneously displays the counts-
per-second. An audio alarm can be programmed to sound when the count rate exceeds a set level, warning of 
high activity.  

Extra large LED's provide a digital display that is clear and visible, even under bright ambient light. A 5-segment 
bargraph LED visually indicates the activity level and speaker volume. 

Classroom demonstrations and nuclear experiments can be run directly from a Macintosh computer running 
using either a serial or USB interface. The provided software renders all of the ST360's controls accessible from 
the Mac and allows real-time data transfer to the computer. This data can be stored for data analysis and 
graphical presentation.  

The software also includes automated features, one of which recycles counting after reaching a preset time, 
which is useful for studying radioactive decay. Another feature automatically increments the high voltage after 
each cycle, which is useful for plotting detector plateaus. 
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Specifications 
 

Inputs:  BNC connector - Accepts standard Geiger tubes. 

   MHV connector - Accepts scintillation detectors. 

 

High voltage: 0 to +1200 volts @ 0.5mA. 

 

Display: 6-decade LED, 1 in. numerals; 5-segment bargraph LEDs 

 

Modes: Counts; Elapsed Time; Preset Time; Count Rate (counts per second); High Voltage Level; Alarm 
Level; Speaker Volume. 

 

Audio:  Includes an audio indication of radiation events and a programmable audio alarm.  

 

Interface: USB and RS-232 serial ports for both PC and Macintosh 

 

Power:   9 volt DC, at 500mA* 

 

Dimensions: 10 inches W, x 7 inches D, x 4.5 inches H 

 

Software:  Windows and Macintosh versions 

 

    *Caution: Use only the AC adapter included with the ST360. Using a different adapter can damage the unit 
and void the warranty. 

 
 



Controls 
Below is a brief description of the ST360's controls. A detailed explanation of the controls is in the following 
Operating Modes section. 

COUNT Control 
The COUNT button starts the timer and event data acquisition. The corresponding LED indicates when the 
unit is counting.  

STOP Control 
The STOP button stops the timer and event data acquisition. The corresponding LED indicates when the unit 
has stopped counting. 

RESET Control 
Pressing the RESET button when counting is stopped, resets the time and counts to zero.  

DISPLAY SELECT Control. 
Pressing DISPLAY SELECT button cycles through each mode in the following order: COUNTS, TIME, RATE, 
HIGH VOLTAGE, ALARM POINT, SPEAKER VOLUME, then back to COUNTS, etc. On the right side of the 
display, a corresponding LED will indicate the selected mode unless the unit is in SPEAKER VOLUME mode 
for which there is no indication LED. 

DOWN and UP Controls 
The DOWN and UP buttons are used for setting the preset time, high voltage, alarm point and speaker 
volume.  

 



Operating Modes 
Below is a description of each mode. As described above, the DISPLAY SELECT button cycles through the 
modes. Modes can be changed at any time, even if the unit is counting, without affecting the data or interrupting 
the count. 

COUNTS Mode.  
The COUNT mode is for displaying the number of radioactive events, or counts. In this mode, the display will 
indicate the number of counts in real time. 

TIME Mode 
The TIME mode is used for either displaying the elapsed acquisition time or for setting the Preset Time. 
When viewing acquisition time, the display shows the time elapsed during the most recent data acquisition. If 
counting is interrupted with the STOP button, and the RESET button is not pressed, the elapsed time will 
begin counting at the point where it stopped. If the RESET button is pressed, the elapsed time will reset to 
zero. 

When in TIME mode, the Preset Time function allows radioactive events to be automatically counted for a 
predetermined amount of time. To engage the Preset Time function, select the TIME mode and enter a value 
using the UP/DOWN buttons. Once counting begins, it will continue for the duration of the preset time value 
and then automatically stop. Pressing COUNT a second time will reset the counts and elapsed time to zero 
and count again for the preset time. Pressing the STOP button will interrupt counting without losing current 
data or resetting the time elapsed. Pressing COUNT again will continue data acquisition for the remaining 
preset time. To stop the Preset Time function, set it to zero. 

RATE Mode  
When the DISPLAY SELECT is set to RATE mode, it provides an instantaneous display of the count rate in 
counts-per-second. This is useful for survey applications, and can be used in conjunction with the ALARM 
feature.  

HIGH VOLTAGE Mode 
This mode is for either displaying, or setting the high voltage level. The high voltage can be set to any value 
between 0 and 1200 volts in 25-volt increments using the UP/DOWN buttons. The COUNT, STOP, or RESET 
buttons do not affect the high voltage setting. 

ALARM POINT Mode. 
This mode is for setting a number that causes an alarm to sound when it is exceeded by the count rate. To 
set the Alarm Point number, select this mode and use the UP/DOWN buttons. The COUNT, STOP, or 
RESET buttons do not affect the alarm point setting. 

SPEAKER VOLUME Mode 
This mode is for displaying or setting the speaker volume and has no associated LED indication. The 
UP/DOWN buttons set the speaker volume. When in this mode, the ACTIVITY/VOLUME bargraph LED 
becomes a speaker volume indicator.  

The ACTIVITY Indicator 
When the unit is counting, the ACTIVITY bargraph on the left side of the display indicates the activity in 
200cps (counts-per-second) increments. That is, one segment indicates a count rate between 200cps and 
400cps, two segments indicate a count rate between 400cps and 600cps, three segments indicate a count 
rate between 600cps and 800cps, four segments indicate a count rate between 800cps and 1000cps, and 
five segments indicate a count rate exceeding 1000cps. The ACTIVITY bargraph is not visible when the 
display is set to SPEAKER VOLUME mode. 



ST360 Software Installation and Operation 
Macintosh Version 

Introduction 
The ST360 software will run on both PowerPC and 68K Macintosh computers. It provides full control of the 
ST360 from the Macintosh and allows the user to save the data. It also enables the features described below in 
the Software Operation section. The latest software revisions are available on our web site at 
www.spectrumtechniques.com. 
Communication using the 9-pin serial port is supported on MAC OS versions 7.1 thru 9.2.2 and on the OSX in 
the Classic Emulation environment. The USB operation is only supported on MAC OS versions 8.6 - 9.2.2. 

Software Installation and Hardware Interface 
The software disk contains the application program, LabLink 360 v #.#.#, a folder named ST360 Notes, and a 
folder named USBDriver for Extensions Folder. The ST360 Notes folder contains a condensed version of the 
software installation and operating instructions. The USBDriver for Extensions Folder holds the USB driver 
USB360, which is required to operate the ST360 when communicating via the USB port. Copy the ST360 
application file to the Mac's Desktop and the USB360 file to the System Extensions folder. 

Connect the Macintosh to the ST360 using either a RS-232 or USB cable. The RS-232 cable will connect from 
either the printer or modem port of the Mac to the RS-232 Mac connector on the 360's rear panel.  

Connect the ST360 to a power source, turn it ON, and open the LabLink 360 application. An introductory window 
will appear with the software version information. Click OK to complete initialization and proceed to the main 
display shown below. 

 



The software will automatically determine which port the ST360 is connected to and perform the necessary 
initializations. A small box in the upper right corner will display the status of communications with the ST360. It 
will read Relinking until communication is established and then read Stopped.  

If communication is not established, a message will appear warning that no ST-360 responded. Clicking OK will 
close the message and the status box will then read I/O Error. In the event that this happens, check to see if the 
ST360 is turned ON and is properly connected. 

If an error occurs using the RS232 serial connection, verify that the software is set to either the modem port or 
the printer port, depending on the connection used. Normally, the software will set this automatically, but it can 
be set manually by selecting Serial Port under the Options menu. Once the problem has been corrected, select 
Serial Relink under Options to re-establish communication. 

The USB interface is not dependent on any other setting. 

 

 

 



Software Operation 
Once the software is executed, it defaults to the Scaler view shown above. Above the ST360 program window 
are the main menu headings. From left to right they are File, Edit, View, Presets, Display, Options, and Font. 

When in Scaler view, the top half of the ST360 program window displays information in four different sections. 
These are Counts, Data Table, Elapsed Time, and Remaining Runs. 

In Digital Rate Meter View, only the counts are displayed in this upper section. The Analog Rate Meter View 
simulates an analog meter by displaying a meter and a moving needle in this upper section. 

Immediately below the upper section of the program window are push-button icons, which represent the Count, 
Stop, and Reset buttons on the ST360. There are LED representations above the Count and Stop buttons to 
indicate their status.  

To the right of these push buttons is the speaker volume control, which can be adjusted via the Dn (Down) and 
Up buttons. Between the Dn and Up buttons is a representation of the ST360's speaker volume bar-graph LEDs. 

In the lower portion of the software window 12 types of information can be viewed simultaneously. These are: 
Preset Time, Elapsed Time, Pause Time, Count, CPS, CPM, Time Left, Alarm, Ramp, Voltage, Runs, and HV 
Limit. 

Note:  When connected to a Macintosh and running the application software, the ST360's controls will 
NOT function, allowing it to only be controlled from the Mac. However, once the ST360 program 
is closed or the unit is disconnected from the Mac, the user will regain use of the ST360's 
controls. 

Menus 
This section describes the menus and their contents. The menus are File, Edit, View, Presets, Display, Options, 
and Font. 

 

File Menu 
The File menu contains New, Save, Save As, Page Setup, Print, and Quit. 

 
New 
Selecting New will reset the Data Table section of the display deleting all of the data. If this section 
contains data that has not been saved, a box appears asking if changes are to be saved. Selecting Yes 
allows the data to be saved before it is deleted. Selecting No will delete the data without saving it. 



Save / Save As 
Save allows the user to save the data contained in the Data Table section. If the data has been saved 
previously it will use the same file name. If the data has not been saved, it will prompt the user for a file 
name and allow a location to be selected. Save As always ask for a file name, whether or not the file has 
been previously saved. 

Page Setup / Print 
Page Setup opens the standard Macintosh page setup box allowing the user to select the page size, 
scaling, and the orientation. Print opens the standard Macintosh page setup box allowing the user to 
configure the printing properties. Selecting OK will print a text representation of the data displayed in the 
Data Table.  

Quit 
Selecting Quit will close the program and return control back to the ST360’s hardware controls. 

Edit Menu 
The Edit menu contains the Copy Data Table, Clear Data Table, and Show Clipboard selections. 

  
Copy Data Table 
Selecting Copy Data Table copies the Data Table's contents to the clipboard.  

Clear Data Table 
Selecting Clear Data Table erases the Data Table. Information copied to the clipboard is not affected 
when the Data Table is erased. 

Show Clipboard 
This displays the contents of the clipboard. 

View Menu 
The View menu contains the three main views of the ST360 program: Scaler, Digital Rate Meter, and Analog 
Rate Meter. The View menu also enables selection of Counts per Second, Counts per Minute and Counts. 

 
Scaler 
When the ST360 program first runs, it defaults to the Scaler view. When in this view, the top half of the 
ST360 program window displays the Counts, Data Table, Elapsed Time, and Remaining Runs sections. 
When Scaler and Counts are selected in the View menu, the Counts section displays the current number 
of radioactive events captured in the most recent data acquisition. When Scaler and Counts per Second 
are selected, the Counts section displays the count rate in counts per second. When Scaler and Counts 
per Minute are selected, the Counts section displays the count rate in counts per minute. 



Digital Rate Meter 
The Digital Rate Meter view displays the counts in counts-per-second or in counts-per-minute. However, 
unlike when in Scaler view, the Digital Rate Meter view does not show the Data Table, Elapsed Time, or 
Remaining Runs sections. The Counts per Second view is identical to the ST360's display when it is in 
Rate mode. The Counts per Minute display is only available using the ST360 software. 

Analog Rate Meter 
The Analog Rate Meter view simulates an analog meter by displaying a meter and a moving needle. The 
meter is also auto-ranging and automatically sets it's self to the correct scale, regardless of the count 
rate. As with the Digital Rate Meter view, the Analog Rate Meter view can show the count rate in Counts 
per Second or in Counts per Minute. 

 

Presets Menu 
The Presets menu allows the Preset Time, Preset Runs, Pause Time, High Voltage, and Rate Alarm to be set 
before counting takes place. 

 
Preset Time 
Preset Time opens a box that displays the available preset time settings in seconds. The setting range is 
in decades from 0 to 900,000 with zero being OFF. To change the setting, click on a number. When the 
setting is reached, the counting will stop automatically. 



Preset Runs 
Preset Runs opens a box that displays the available preset run settings with zero being OFF. To change 
the setting, click on a number. 

Preset Runs is used in conjunction with Preset Time. The Preset Runs setting determines the number of 
times a count cycle is automatically repeated. Once all the runs have executed, counting will 
automatically stop. During this operation, the Remaining Runs section of the main view displays the 
remaining runs.  

 
When used with the Step Voltage feature, Runs allows the user to automatically graph a detector's 
plateau. This is explained in the section "Creating a Plateau Chart". 

Pause Time 
Pause Time is used in conjunction with Preset Time and Runs. It causes the counting to pause for a 
predetermined number of seconds between runs. When Pause Time is selected, a box appears allowing 
the Pause Time to be selected.  

High Voltage 
High Voltage opens a box that displays the available high voltage settings in 25-volt increments with zero 
being OFF. Clicking on a number will immediately turn the high voltage On and set it to the selected 
value.              

Rate Alarm 
Rate Alarm opens a box that displays the available alarm rate settings with zero being OFF. The settings 
are given in counts per second. When the count rate exceeds this limit, an audio warning will sound until 
the count rate falls below the limit. 

Display Menu 
The Display menu enables the Macintosh to change the ST360's hardware display. For example, if Counts is 
selected from the Display menu, the ST360's display will switch to the Counts mode 

 



Options Menu 
The Options menu consist of Voltage Ramp On, Voltage Ramp Off, HV Limit, Start Counting, Stop Counting, 
Reset, Serial Relink, Serial Port, Scale Up, Scale Down, Format Times and Show Date.  

 
Voltage Ramp On 
Causes the high voltage to automatically increment in steps of 25 volts from the current setting to the HV 
Limit setting during a cycle of Runs. 

HV Limit 
Selects the upper voltage limit for the Voltage Ramp. 

Voltage Ramp Off 
Disables the Voltage Ramp feature. 

Start Counting 
Functions the same as the Count button. 

Stop Counting 
Functions the same as the Stop button. 

Reset 
Functions the same as the Reset button. 

Serial Relink 
Causes a re-initialization of the serial connection link. This Command is only used when a serial 
connection has been inadvertently broken and an I/O Error is reported in the Status field. 

Serial Port 
Allows either the Modem Port or the Printer Port to be manually selected for serial communications. 
Otherwise, the port is selected automatically from all available ports when the application is started. 

Auto Scale 
Enable/disable automatic scaling of the Analog Rate Meter display. 

Scale Up 
If not in Auto Scale mode, this command will adjust the meter scaling Up to the next range. The  >> 
Scale icon located at the top of the display may be used to perform the same function. 



Scale Down 
If not in Auto Scale mode, this command will adjust the meter scaling Down to the next range. The  << 
Scale icon located at the top of the display may be used to perform the same function. 

Format Times 
This changes the preset and elapsed time formats from seconds to hours:minutes:seconds.  

Show Date 
Enable/disable showing of the date along with time in the upper most right corner of the software display.  

Font 
This menu displays the available printer fonts for your computer. The default font used is 'Times'. Font 
changes are limited to the Scaler and Rate Meter software selected displays. 

 

Command Button Icons: 
The Command Button Icons consists of the Count, Stop, and Reset icons and function the same as the 
hardware buttons on the ST360. 

 
Selecting the Count icon begins counting. 

Selecting the Stop icon stops counting. 

Selecting the Reset icon erases accumulated counts, elapsed time and remaining run values. The Data Table is 
not affected by this function.   

Speaker Volume 
The Dn (down) and Up buttons provide control of the ST360's speaker volume. Clicking on Dn lowers the 
speaker volume and clicking on Up raises it. In addition, the bargraph display represents the speaker volume 
setting just like its hard ware counter-part on the ST360. 

                                       



Information Display Sections: 
As shown below, the Scaler view has four sections for displaying information: Counts, Run Data, Elapsed Time, 
and Remaining Runs. 

 

Counts Section 
The Counts section displays either the current number of counts or the count rate, depending on how it is set. 
As stated earlier, this setting can be changed by going to the View menu and selecting Counts Per Second, 
Counts Per Minute or Counts.  

Another way of changing views is by "clicking" the area with the mouse. When the cursor is placed over this 
section, it changes shape and the word SET appears below it. When this area is clicked once, it changes to 
display the rate in counts per second. When this area is clicked a second time, it displays the rate in counts 
per minute. When it is clicked a third time, the display changes back to Counts. 

Data Table Section 
The Data Table section displays information for each data acquisition. This information includes Run, HV 
(high voltage setting), Counts, Time (elapsed time in seconds), and the Time Of Day and Date the data was 
acquired. 

Elapsed Time Section 
The Elapsed Time section displays the time elapsed during counting. The elapsed time will reset to zero 
when either the Reset button is pressed or when counting is re-started after the end of a preset time. If a 
preset time is not set, or counting is interrupted with the Stop command, the elapsed time will not reset and 
will continue running when Count is selected again.  

As described earlier, the Time format can be changed by selecting Format times under the Options menu. 
Another way of changing the time format is by "clicking" the Elapsed Time area with the mouse. When the 
cursor is placed over this section, it changes shape and the letters FMT appears below it. When this area is 
clicked, the time format will toggle between seconds and hours:minutes:seconds.  

Remaining Runs Section 
The Runs Remaining section displays the remaining number of runs set by the Preset Runs function. 



Lower Display Section: 
The lower display section is shown below.  

 
It displays a summary of various data and presets. These are Preset Time, Elapsed Time, Pause Time, Count, 
CPS (counts per second), CPM (count per minute), Time Left (remaining Preset Time), Alarm (OFF or ON), 
Ramp (OFF or ON), Voltage (High Voltage setting), Runs, and HV Limit. 

If the mouse pointer is clicked over the Preset Time, Elapsed Time, Pause Time, or Time Left, the time format 
will toggle between seconds and hours:minutes:seconds. 

Clicking the mouse pointer over Ramp, toggles it between OFF and ON. 

 



System Operation 
Warning! 

Dangerous voltages can exist at the GM and SCINT connectors. Do not connect or disconnect a detector 
unless the high voltage is set to zero or the instrument is turned OFF. 

Caution: 
The ST360 was designed and calibrated to work with either a GM tube or a scintillation detector, but not both 
at the same time. Simultaneously connecting both to the ST360 will result in erroneous data. 

Basic GM Tube Setup and Operation 
1. Connect the ST360 to its AC adapter. 

2. Connect a GM tube to the GM connector using a BNC cable. 

3. Select the HIGH VOLTAGE mode and set it to the recommended value for the GM tube. 

4. Place the radioactive source under the GM tube's window. 

5. Using the information described in the section Operating Modes and Software Operation, configure the 
ST360 and it's software to perform the desired operation. 

GM Tubes 
Geiger-Mueller tubes produce electrical pulses when ionizing radiation events occur within their sensitive 
volume. To improve sensitivity to alpha and beta particle radiation, GM tubes have extremely thin entrance 
windows, which require careful handling. Keep the protective caps in place when the tube is not in its stand and 
never touch the window. For proper operation, only run these detectors at the manufacturer's specified voltage. If 
this voltage is not known, then it must be derived empirically by plotting a plateau, which is explained in the next 
section.  

Creating a GM Tube Plateau Chart 
The correct operating voltage for the Geiger-Mueller tube may be determined experimentally using a radioactive 
source such as Cs-137 or Co-60. A properly functioning tube will exhibit a "plateau" effect, where the counting 
rate remains nearly constant while the high voltage is increasing linearly. A plateau chart is obtained by counting 
a source for several runs using a constant preset time, while increasing the high voltage by a constant amount 
with each run. 

Creating a Chart Manually 
1. Place the radioactive source in a fixed position close to the window of the GM tube.  

2. Put the ST360 into COUNT mode and increase the high voltage until the first bar of the ACTIVITY 
bargraph lights. Press STOP and RESET. 

3. Set the Preset Time to 10 seconds and press COUNT again. 

4. When the Preset Time expires, record the counts and the voltage setting. 

5. Increase the high voltage 20 volts and press COUNT again.   

6. Repeat steps 4 and 5 until the high voltage reaches its upper limit (this is determined by the upper 
operating voltage limit of the detector). 

7. Create an X-Y graph of the data, with "Y" being the Counts, and "X" being the voltage. 



Using the ST360 Software 
1. Place the radioactive source in a fixed position close to the window of the GM tube. 

2. Put the ST360 into Count mode and increase the high voltage until the first bar of the ACTIVITY 
bargraph lights. This is the starting voltage.  

3. Select High Voltage in the Presets menu and set it to the starting voltage. Under the Options menu, 
select Voltage Ramp On. 

4. Determine the upper operating voltage limit of the detector. Under the Options menu, select HV Limit 
and set it just below the detector’s upper voltage limit. 

6. Select Preset Time in the Presets menu and set it to 10 seconds. 

7. Begin counting. The program will count for 10 seconds, record the value, and increment the high 
voltage. This process will automatically repeat itself until the upper voltage limit is reached. 

8. After data is acquired, save it to a file. Use the file to create an X-Y graph of the data, with "Y" being the 
Counts, and "X" being the voltage. 

The following illustration shows a typical GM tube plateau: 

 
Notice that the counts form a relatively flat place on the graph between 850 and 1100 volts. The center of this 
area is at approximately 1000 volts and is the recommended operating voltage for this detector. However, any 
voltage in this flat region would be acceptable. Also, notice that the counts increase rapidly as the high voltage 
nears its upper limit. This indicates that the tube is entering its breakdown region. Do not continue to operate the 
tube in this region. 



Resolving Time 
Geiger-Mueller tubes exhibit dead time effects due to the recombination time of internal gas ions after an ionizing 
event occurs. The actual dead time depends on several factors including the active volume and shape of the 
detector. Dead time can range from a few microseconds for miniature tubes, to over 1000 microseconds for 
large volume devices. 

When making absolute measurements it is important to compensate for dead time losses at higher counting 
rates. If the resolving time of the detector is known, the true counting rate may be calculated from the measured 
rate using the following expression: 

            m  
      n = ———— 
         1 - mt 
where n is the true counting rate, m the measured rate, and t the detector resolving time. 

If the detector resolving time is unknown, it may be determined experimentally using two radioactive sources. 
Maintaining constant counting geometry is important throughout the experiment. A special source split into two 
halves (Spectrum Techniques part # RSS-2) is available for making the measurement, but nominal results may 
be obtained by careful positioning of two standard check sources. Perform the following steps to calculate the 
resolving time: 

1. Set the high voltage to the GM tube’s correct operating voltage. 

2. Set the Preset Time to 60 seconds. 

3. Position the two sources (a+b) side-by-side and close enough to the GM tube's window to obtain a count 
rate of at least 10,000 counts per minute. 

4. Press COUNT. When counting stops, record the number of counts as R(a+b). 

5. Remove source (b) and Press COUNT. When counting stops, record the number of counts as R(a). 

6. Carefully replace source (b) to its original position and remove source (a). Press COUNT. When counting 
stops, record the number of counts as R(b). 

7. Solve for the resolving time using this equation: 

                 ┌  R(a)+R(b)-R(a+b)   ┐ 
         t = │ ——————————————— │•60 
             └    2R(a).R(b)     ┘ 
 

The resolving time of the ST360 Radiation Counter is very short and is not a significant factor compared to that 
of the GM tube. 

 



The Wipe Test System 
The ST360 Radiation Counter will also operate with a NaI(Tl) scintillation tube for detecting low-level gamma and 
X-ray emission from a variety of samples. The Wipe-Test system includes a well detector, base, cable, and lead 
shield for measuring wipes or tube samples.  

This system will detect gamma and X-rays ranging in energy from 20 keV to several meV. Each system is 
factory calibrated and should not require further adjustment unless a different detector or tube base is used. A 
Cs-137 calibration source is included for routine checking of overall system performance and quality assurance. 
Details of the system’s setup, operation, and calibration are covered in the following sections. 

Scintillation Detector Setup 
The Wipe Test system should be set up in the following manner: 

1. Install the scintillation detector into the socket of the tube base/stand. Note that the base of the detector 
is keyed and will only locate in one position of the socket. 

2. Place the lead shield over the top of the detector allowing it to rest on the vertical metal support tube. 

3. Insert the plastic liner into the well.  

       Caution:  This liner provides protection from mechanical damage and contamination. The 
aluminum wall inside the well is very thin and can be damaged if a tube or rod is 
inadvertently dropped into the well without the liner in place. 

4. Connect the coaxial cable from the detector assembly to the input labeled SCINT on the rear panel of 
the ST360. 

5. Turn the ST360 ON. Using either the ST360 program or the front panel controls set the high voltage to 
the value marked on the detector assembly. 

6. Set the Preset Time to the desired number of seconds and begin counting. 

Checking the System Calibration 
Use the supplied calibrated Cs-137 source to check the counting efficiency and overall system performance. 
This source has its activity marked in counts per minute (cpm) and the date of manufacture. Over time, the 
source decays with a half-life of 30.1 years and it will be necessary to periodically correct the activity. 

1. Place the calibrated Cs-137 source into the plastic well liner and into the well of the detector. 

2. Set the Preset Time to 60 seconds and begin counting 

3. After counting is finished, the reading should correspond within ±10% of the activity in cpm recorded on 
the source. For better accuracy, use the average of three separate readings. 

Taking a Background Reading 
Wipe tests are inherently low-level measurements and it is necessary to perform background subtraction on all 
samples to generate accurate activity data. Because the background reading is low, it should be counted for a 
longer period to improve the statistics. 

1. Remove all radioactive material from the vicinity of the detector. 

2. Set the Preset Time to 600 seconds and begin counting. 

3. When counting is complete, record the value and divide it by 10 to derive the background counts-per-
minute.  

Measuring Wipes 
1. Using the well-liner, position the sample into the well of the detector. 

2. Set the Preset Time to 60 seconds and begin counting. 

3. When counting is complete, record the count. 

4. Subtract the background counts-per-minute and record the value. This is the correct counts/minute for 
the sample. 



System Re-calibration 
The system is calibrated at the factory. Under normal circumstances, recalibration should not be required. 
However, in the event that the detector or tube base is replaced, it will be necessary to re-determine the correct 
operating voltage for the system. To do this, repeat the section Scintillation Detector Setup using the new 
detector or tube base. Using the Cs-137 source supplied with the system, refer to the section Creating a Plateau 
Chart to obtain a chart like the one shown below. The operating voltage is found by selecting the point just to the 
right of the highest knee. In the example below, the operating voltage would be 950V. 

 

Warranty and Repair Information 
Spectrum Techniques warrants products of our manufacture against defects in workmanship or material for a 
period of one year from the date of shipment. We will repair or replace, at our option, any instrument that is 
deemed defective during this time. This warranty covers all replacement parts and labor. The instrument must be 
returned to our factory prepaid and we in turn will pay the cost of the return shipping. 

The warranty does not cover damage caused by mishandling or misuse. GM tubes with broken windows are 
specifically excluded from this warranty. Accessory items not manufactured by Spectrum Techniques but 
supplied as part of our systems will be subject to the original manufacturer's warranty. 

For warranty repair information and return authorization, contact customer service at: 

 

     Spectrum Techniques 
     106 Union Valley Road 
     Oak Ridge, TN 37830 
     Tel: (865) 482-9937 
     Fax: (865) 483-0473 
     www.spectrumtechniques.com 
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